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	[bookmark: _Toc271527085][bookmark: _Toc446329733]Lesson Description

	TMS #
	4181474

	[bookmark: _Toc269888397][bookmark: _Toc269888740]Prerequisites
	None

	target audience
	The target audience for Tour of MAP-D is VSR.

Although this lesson is targeted to teach the VSR employee, it may be taught to other VA personnel as mandatory or refresher type training.

	[bookmark: _Toc269888398][bookmark: _Toc269888741]Time Required
	1.5 hours

	[bookmark: _Toc269888399][bookmark: _Toc269888742]Materials
	Lesson materials:
Tour of MAP-D PowerPoint Presentation
Tour of MAP-D Trainee Handout
Tour of MAP-D Lesson Plan

	Training Area/Tools 
	The following are required to ensure the trainees are able to meet the lesson objectives: 
A claim number with an active claim so that the instructor can navigate through MAP-D on the projector
Classroom or private area suitable for participatory discussions
Seating, writing materials, and writing surfaces for trainee note taking and participation 
Handouts, which include a practical exercise
Large writing surface (easel pad, chalkboard, dry erase board, overhead projector, etc.) with appropriate writing materials
Computer with PowerPoint software to present the lesson material

Trainees require access to the following tools: 
VA TMS to complete the assessment
VA Intranet




	Pre-Planning 

	[bookmark: _Toc46738919][bookmark: _Toc46738985][bookmark: _Toc46739118][bookmark: _Toc46739151][bookmark: _Toc46739632][bookmark: _Toc48125390][bookmark: _Toc265570467]Become familiar with all training materials by reading the Instructor Lesson Plan while simultaneously reviewing the corresponding PowerPoint slides. This will provide you the opportunity to see the connection between the Lesson Plan and the slides, which will allow for a more structured presentation during the training session. 
Become familiar with the content of the trainee handouts and their association to the Lesson Plan. 
Practice is the best guarantee of providing a quality presentation. At a minimum, do a complete walkthrough of the presentation to practice coordination between this Lesson Plan, the trainee handouts, and the PowerPoint slides and ensure your timing is on track with the length of the lesson. 
Ensure that there are copies of all handouts before the training session.
When required, reserve the training room.
Arrange for equipment such as flip charts, an overhead projector, and any other equipment (as needed).
Talk to people in your office who are most familiar with this topic to collect experiences that you can include as examples in the lesson. 
This lesson plan belongs to you. Feel free to highlight headings, key phrases, or other information to help the instruction flow smoothly. Feel free to add any notes or information that you need in the margins. 

	Training Day 

	Arrive as early as possible to ensure access to the facility and computers. 
Become familiar with the location of restrooms and other facilities that the trainees will require. 
Test the computer and projector to ensure they are working properly. 
Before class begins, open the PowerPoint presentation to the first slide. This will help to ensure the presentation is functioning properly. 
Make sure that a whiteboard or flip chart and the associated markers are available.
The instructor completes a roll call attendance sheet or provides a sign-in sheet to the students. The attendance records are forwarded to the Regional Office Training Managers. 




	[bookmark: _Toc446329734]Introduction to Tour of MAP-D

	INSTRUCTOR INTRODUCTION
	Complete the following:
Introduce yourself
Orient learners to the facilities
Ensure that all learners have the required handouts

	time required
	0.25 hours

	[bookmark: _Toc269888401][bookmark: _Toc269888744]Purpose of Lesson
	This lesson is intended to introduce trainees to MAP-D. The trainer will provide a tour of the MAP-D program and discuss how to draft a development letter.

	[bookmark: _Toc269888402][bookmark: _Toc269888745]Lesson Objectives

Slide 2

Handout  2

	In order to accomplish the purpose of this lesson, the VSR will be required to accomplish the following lesson objectives.

The VSR will be able to:  
Understand the purpose of the MAP-D program
Navigate the MAP-D program
Draft a development letter using the MAP-D program

Each learning objective is covered in the associated topic. At the conclusion of the lesson, the learning objectives will be reviewed.

	[bookmark: _Toc269888403][bookmark: _Toc269888746]Motivation
	Although the majority of development is currently accomplished through the VBMS Core program, there are occasions where MAP-D is needed to complete a development task.  It is important that the trainee is familiar with the MAP-D program so that said development is completed correctly.

	STAR Error code(s)
	N/A

	[bookmark: _Toc269888405][bookmark: _Toc269888748]References

Slide 3

Handout 3
	Explain where these references are located in the workplace.
MAP-D User Guide


[bookmark: _Toc269888406][bookmark: _Toc269888749][bookmark: _Toc269888789]


	[bookmark: _Toc446329735]Topic 1: A Tour of MAP-D

	[bookmark: _Toc269888407][bookmark: _Toc269888750]Introduction
	VBMS was developed with MAP-D in mind.  Although they are different programs, a user familiar with one is inherently familiar with the other.  Both programs are fairly user-friendly.  As long as one has a basic knowledge of where to find things in MAP-D, using the program is not that difficult.

	[bookmark: _Toc269888408][bookmark: _Toc269888751]Time Required
	0.50 hours

	OBJECTIVES
	Topic objectives:
Understand the purpose of the MAP-D program
Determine how to log on to MAP-D
Navigate the MAP-D program

	REFERENCES
	· MAP-D User Guide

	The Purpose of 
MAP-D

Slide 4

Handout 4


	MAP-D stands for Modern Awards Processing Development.  It is a legacy program that was used to draft development letters and track development items.  Public contact employees could also use MAP-D to respond to claim inquiries from claimants.  MAP-D has been largely replaced by VBMS Core; however there are some development actions that can only be accomplished in MAP-D.  Most importantly, all dual claim development (compensation and pension) must be done through MAP-D.

MAP-D includes the following features:
· Comprehensive information about the claimant and the claim
· Letter generation

Although MAP-D can do much more than what is listed above, VBMS Core should be used to accomplish any other tasks not listed above (i.e., pending issue control, creating notes, and development tracking).

Instructor Note: Any of the development actions that we are still using MAP-D to accomplish could be included into VBMS Core in future releases.  Before giving the training, familiarize yourself with what development actions for which MAP-D is still required.  Speak to one of your station’s VBMS Super Users to ensure the correct information is provided during the training.  Also, let the trainees know that this list could change at any time and they need to keep current with new VBMS features.


	How to Log On to MAP-D

Slide 5

Handout 4

	To log into MAP-D, you should pull up the Windows Start Menu and navigate to the MAP-D program icon.  There are two ways to accomplish this:
1. Click on the Start Menu.  Click on All Programs.  Click on VBAPPS.  Click on VETSNET.  Click on MAPD T11.
2. Click on the Start Menu.  Type MAPD into the search bar.  Click on MAPD T11.

If this is your first time logging into a VA program for the day, a login screen will pop up before MAP-D is loaded.  Enter you station number and CSS (Common Security Systems) password.  MAP-D will then load.

DO NOT create a shortcut to the program on your desktop as this could prevent updates from being automatically downloaded to your computer.

	Tour of MAP-D

Slide 6-7

Handout 4-5

Instead of lecturing about the different functions of MAP-D, walk the trainees through the different screens mentioned in this training.
	There are multiple screens in MAP-D and different ways to navigate to them.  Since MAP-D is only utilized to draft certain development letters that cannot be accomplished in VBMS Core, the tour will be limited to the pertinent screens and methods to reach those screens.

After logging into MAP-D, the first screen you will encounter will be a Release Notes screen.  After waiting for the log-on script to run, click OK to enter into the MAP-D program.  The next screen you will encounter will be the Work List screen.  This screen will not contain any information and is no longer utilized.

There are a number of drop-down menus along the top of the program window:
· File
· Edit
· Claims
· Profiles
· Auto Development
· GoTo
· Other Apps
· Help





The only drop-down menus that are currently used are the File, Edit, Other Apps, and Help options.  The File menu allows you to search for a claim, initiate development (more on this later), and exit the program.  You can also exit MAP-D by clicking on the X button on the upper right portion of the MAP-D window.  Traditional Windows hot keys (i.e., CTRL+C for copy) will not work within MAP-D.  If you need to copy, paste or cut something from or into MAP-D, you will have to use the function under Edit menu.  If needed, you can launch other apps (i.e., SHARE, CAPRI, or COVERS) from the Other Apps menu; however, users generally use the Windows Start Menu to launch these apps.  Lastly, the Help menu has options that lead the user to the 
MAP-D User Guide, release notes, and other help documents.  These documents are still being updated and do contain useful information.  If you encounter an issue with MAP-D, you can refer to these help documents or your station’s MAP-D Super User.

To get to the Customer Service screen (which is where development actions are completed), then click on the File menu and then the Search option.  A pop-up window will appear.  Insert the Veteran’s claim number or social security number into this pop-up window.  The Customer Service screen contains a plethora of information about the Veteran’s current and past claims.  For the intent of this training, we will not cover the entirety of this screen because all of this information can be found in VBMS Core.

The next step on our path to the development area of MAP-D is to navigate to the Contention screen.  On the left side of the screen, click on the pending claim (i.e., 010, 020, or 110) and then click on the Contentions button on the bottom-right side of the screen.  You will now be on the Contentions screen.  This screen also contains a plethora of information, but again all of this information can be found in VBMS.

To create a development letter addressing a third party records holder, click on the 3rd Party button.  To create a development letter addressing the Veteran, click on the Claimant Ltr button.  If at any time, you are presented with a question to initiate automatic development, you should always select NO.  The Automatic Development function has been broken for some time and is disabled in MAP-D.  Selecting YES will just cause an error to occur within the MAP-D program.


	[bookmark: _Toc269888412][bookmark: _Toc269888755]EXERCISE
	None




	[bookmark: _Toc446329736]Topic 2: Creating a Development Letter

	Introduction
	MAP-D has been largely replaced by VBMS Core; however there are some development actions that can only be accomplished in MAP-D.  The VSR needs to have the ability to draft these letters in MAP-D so that the VA can provide the Veteran with the appropriate information or gather any necessary third party records.

	Time Required
	0.50 hours

	OBJECTIVES

	Topic objectives:
· Draft a third party development letter using the MAP-D program
· Draft a claimant letter using the MAP-D program

	REFERENCES
	· MAP-D User Guide

	Third Party Development Letters

Slide 8-10

Handout 6-7


	There are three categories of third party requests, Letter, NPRC/DPRIS, and VHA.  The Letter category is the only category that actually contains letters that are sent out to a third party requesting records.  The NPRC/DPRIS and VHA categories contain development items that are accomplished through PIES, DPRIS, CAPRI, or other programs.  Any of the items under the NPRC/DPRIS or VHA options are not currently being utilized as these items can be found in VBMS Core.

Unlike development letters that the VA sends to the claimant, only one development action should be selected per third party development letter.  After clicking on the Letter radio button, select the appropriate development action on the left side of the screen.  Then select the > button to move the development action over to the right side of the screen. Depending on the development action, a pop-up window may appear.  If this occurs, you should fill in the appropriate information.  Next select the Add/Edit button and enter the third party record holder’s complete address.  Before continuing on, you should ensure all information has been selected and entered correctly up to this point.  To move to the Print Letter screen, select the To Continue button.   Unlike VBMS Core, you can not only preview the letter but also make changes to the letter itself in a Word document.  To view the letter, select the development letter and the Word button.  This will open the document in Word.  You can make any necessary changes, save the document, and the close out of the Word document.  Just because changes can be made to the development letter, does not mean that changes must be made.  Please ensure any changes to VA approved language are necessary and correct.  



Notice that a claimant letter was created concurrently with the third party development letter notifying the Veteran of our development attempts.  You do not need to worry about the content of this letter as it will not be used.  VBMS Core should be used to notify the Veteran of these third party development actions.  The user can select the claimant letter and remove it from the Print Letter screen.  To do this, select the claimant letter and then select the Edit button.  Select any development items on the right side of the screen and select the < button to remove them from the letter.  Then select the To Continue button to return to the Print Letter screen.  The claimant letter should now be gone from the Print Letter screen.  

After removing the claimant letter and checking the third part development letter for accuracy, select the Final Print button.  Before selecting this button, ensure that your default printer is set to Adobe PDF.  If it is not, then you will have to change your default printer, exit MAP-D, and then return to this screen.  You should then generate a PDF version of the development letter and uploaded that into VBMS Core.  You can then print the letter from VBMS Core.  You should only be printing one physical copy of the letter (for the third party records holder.   Remember to create a tracked item in VBMS Core to track the development items in this letter.

After selecting the Final Print button, you will be taken to the Claim Level Suspense Method screen.  You should not select anything on this screen other than the Cancel button.  A pop-up will appear that asks whether you want to save or not.  You should not save.  You should use tracked items in VBMS Core to control the suspense reason.   You will now be back on the Customer Service screen.  

Since MAP-D is considered a legacy system and the VA is not using the program to track any development, you will need to remove the third party development letter just created.  To accomplish this, select Letters underneath the pending claim.  Select the letter you just created and then select the Return to Development button.  You will now be back on the Customer Service screen.  Select the Non Follow Up-Dev Actions Not Completed text.  This will take you back to the Print Letter screen.  The same steps to remove the claimant letter can be used to remove the third party letter.  Once the third party development letter has been removed, you can select the Close button.

Remember; the process of creating a development letter through 
MAP-D only needs to be completed when the development action needed cannot be accomplished through VBMS Core.



	Letters to the Veteran

Slide 11

Handout 7

	On the Claimant Letter screen, there are a number of development items you can choose by navigating through the drop-down categories.  Remember; you should only use MAP-D for development items that are not available in VBMS Core.

You can add development items to the claimant letter using the same method described above for third party development letters.  However, unlike the development process for third party letters, you can select multiple development actions to be included in the claimant letter.

Just as with the third party development letters, occasionally a pop-up box may appear when selecting development items.  Be sure to correctly fill in the box before moving on.

After selecting all necessary development items, select the To Continue button.  You will now be taken to the Print Letter Screen.  Before reviewing the letter, a claimant letter format will need to be selected.  In most scenarios, the format will always be Subsequent Contact.  You can then review and edit the letter using the same process as mentioned above.

The printing process is also the same as mentioned in the third party development letters section above.  Remember; you should ensure their default printer is Adobe PDF, upload that letter to VBMS Core, print the letter from VBMS Core and add any tracked items in VBMS Core.  You should also delete the letter following the same process mentioned above.

	Exercise
	None


[bookmark: _Toc269888426][bookmark: _Toc269888769][bookmark: _Toc269888792]

	[bookmark: _Toc446329737]
Lesson Review, Assessment, and Wrap-up

	[bookmark: _Toc269888427][bookmark: _Toc269888770]Introduction
	The Tour of MAP-D lesson is complete. 

Review each lesson objective and ask the trainees for any questions or comments.

	[bookmark: _Toc269888428][bookmark: _Toc269888771]Time Required
	[bookmark: _GoBack]0.25 hours 

	[bookmark: _Toc269888429][bookmark: _Toc269888772]Lesson Objectives
	You have completed the Tour of MAP-D lesson. 

The trainee should be able to:  
· Understand the purpose of the MAP-D program
· Navigate the MAP-D program
· Draft a development letter using the MAP-D program

	Assessment 

	Remind the trainees to complete the on-line assessment and survey in TMS to receive credit for completion of the course.

The assessment will allow the participants to demonstrate their understanding of the information presented in this lesson.

The survey will allow participants to provide feedback on how Compensation Service can enhance the training course.
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